BRAND GUIDELINES

Modified:
5/29/13
Table of Contents

1 BRAND FOUNDATION
1.1 What is a Brand?
1.2–3 Brand Story
1.4 Brand Promise
1.5 Brand Attributes
1.6 Brand Concept
1.7 Key Messaging
1.8 Brand Architecture
1.9 Integrated Marketing

2 LOGO STANDARDS
2.1 Logo: Icon Overview
2.2 Logo: Icon and Logotype
2.3 Configuration: Horizontal
2.4 Configuration: Vertical
2.5 Spacing and Dimensions: Clearspace
2.6 Spacing and Dimensions: Minimum size
2.7 Color Specifications: Primary Usage
2.8 Color Specifications: Reversals
2.9 Color Specifications: with Screens
2.10 Color Specifications: with Photography
2.11 Color Specifications: Unacceptable Usage
2.12 Presidential Seal

3 BRAND IDENTITY
3.1 Color Palette: Primary Colors
3.2 Color Palette: Secondary Colors
3.3 Color Palette: Tints
3.4 Color Palette: Color Combinations
3.5 Typography: Print and Graphic Text
3.6 Typography: Special Use
3.7 Typography: HTML Text
3.8 Photography: Introduction
3.9–10 Photography: By Attribute

4 BRAND APPLICATION
4.1 Print Examples: Business Card
4.2 Print Examples: Letterhead
4.3 Print Examples: Envelope
4.4–7 Print Examples: Cover Overview
4.8–12 Print Examples: Brochure Spread
4.13 Print Examples: 3 Panel Brochure
4.14 Print Examples: Insert Template
4.15 Print Examples: Direct Mail
4.16 Print Examples: Poster
4.17 Digital Examples: Email Signature

A ADVANCED GUIDELINES APPENDIX
LOGO STANDARDS cont’d
A.1 Special Use Logos: Alternate Versions
A.2 Special Use Logos: Department
A.3 Special Use Logos: Logotype Only
A.4 Special Use Logos: Icon Only
BRAND IDENTITY cont’d
A.6 Photography: Concept
A.7 Photography: Layout
A.8 Graphics: Typography
A.9 Graphics: Iconography
A.10 Graphics: Infographics and Objects
A.11 Layout: Grid
A.12 Layout: Composition
A.13 Layout: Layering
A.14 Messaging: Live It Header
A.15 Messaging: Question Header
A.16 Messaging: Action Word
ADVANCED BRAND APPLICATION cont’d
A.17 Detail: Profile Treatments
A.18 Detail: Trajectory Treatment
A.19 Special Initiatives
A.20 Poster: Brand Specifications
A.21 Digital Examples: Email Template
A.22 T-shirt: Brand Specifications

B DESIGNER’S APPENDIX
B.1 Creating ‘Full Emotion’ Photography
B.2 Creating a Grid Using Any Format
B.3 Print Production Specifications
BRAND FOUNDATION

1.1 What is a Brand?
1.2 Brand Story
1.4 Brand Promise
1.5 Brand Attributes
1.6 Brand Concept
1.7 Key Messaging
1.8 Brand Architecture
1.9 Integrated Marketing
What is a Brand?

A brand is the total of all the experiences anyone has with Hope College. It is different for each person, whether they are a student, alumnus/a, faculty, staff or donor.

Overview

Consciously developing and choosing a brand identity is a powerful way to build and strengthen connections with all of our constituents. By becoming more thoughtful and consistent about what is most important and relevant about Hope College, we can all pull together. We speak with a stronger voice. We make the most of our resources.

The process of branding asks central questions, such as:

> How is Hope distinctive?
> How does Hope’s mission and vision guide our brand?
> What about Hope is most important and compelling to those we serve—students, parents, alumni/ae, friends of the College, our community?
> What about Hope is most important and compelling to those who provide service—faculty, staff, administrators?

A successful brand must honestly reflect who we really are as a college. It should communicate what matters most, powerfully and persuasively.

Contained within these guidelines are tools to communicate Hope’s brand and story. They include a bit of background about how this brand was developed, direction and rationale for using elements of the brand platform, and examples of communications Hope has created using the new brand identity.

We live our brand.

Because a brand is the total of all the experiences someone has with Hope College, any of us who represents Hope (student, staff, alumnus/a or employee) shapes the College’s reputation and how others experience it. The success of our brand is up to us.

While marketing and advertising are the most prominent representations of the brand, the visitors we talk with, the students we assist, the phone calls we answer, are equally important, if not more important.

Hope is a welcoming place because we make it so—saying hello as we walk the campus, opening doors for others, offering a warm drink to visitors coming in from the cold, helping and caring for one another.

The College’s reputation for excellence in teaching and student outcomes rests on the dedication of each of our faculty members and those who support them. The dedication our students bring to campus exemplifies the value they place on education and an understanding of their impact on the world.

Our great traditions of the Pull, Nykerk, Dance Marathon and others rely on the continued gifts of thousands of hours by students, staff and faculty. Championship athletic teams with scholar-athletes succeed only with the shared commitment to athletic and academic excellence among coaches, athletics, faculty and staff, and the community.

We are an intentional community, who make careful choices in the work we undertake and the decisions we make. We are thoughtful in our use of the resources available to us be they knowledge, relationships, facilities or our physical environment. We seek sustainability in all endeavors.

In short, our words and deeds continue to bring the Hope brand to life. This brand platform gives us all communication tools, empowering us to express the Hope brand in our words and actions.
Out of faith and charity, Hope College was born.

Hope’s story begins with the October 1851 creation of the Holland colony’s “Pioneer School.” The Pioneer School eventually evolved into “The Holland Academy” and then the college as the community’s educational needs progressed from elementary to secondary to college.

The Pioneer School was founded with support from the Reformed Church in America to educate the community’s children in the context of the Christian faith. The Rev. A.C. Van Raalte wanted Holland’s children to receive education with a Christian character—an option not guaranteed through state-supported schooling.

The Pioneer School found its first home in a building called the “Orphan House”, originally slated to house parentless children within the community. Through their charity and generosity, surviving Holland colonists adopted all orphaned children into their own homes allowing the building to be repurposed for education.

But that is only the beginning...
An authentic brand flows from the mission, vision and lived experience of the college.

The mission of Hope College is to educate students for lives of leadership and service in a global society through academic and co-curricular programs of recognized excellence in the liberal arts and in the context of the historic Christian faith.

**Vision Statements**

- to pursue truth so as to renew the mind, enrich the disciplines, and transform the culture
- to inspire passion for knowledge that grows into understanding and bears fruit in wisdom
- to be an exceptional liberal arts college that provides excellent professional and pre-professional programs
- to be a leading Christian college, ecumenical in character and rooted in the Reformed tradition
- to enhance education through residential community and superior co-curricular programs

**Core Values**

- to offer rigorous academic programs
- to contribute to the body of knowledge in the academic disciplines
- to nurture vibrant Christian faith
- to be a caring community
- to foster development of the whole person — intellectually, spiritually, socially, physically
- to be wise stewards of resources
Brand Promise

The brand promise defines what Hope College intends to be and the experience an individual can expect to have when engaging with the institution.

The brand promise is for internal use and is different than Hope’s mission statement.

Hope College’s Promise:

Hope College inspires students to be fully alive in mind, body and spirit through an exceptional liberal arts education and a community grounded in a vibrant Christian faith.

Successful brand communications must honestly reflect who we are as an institution. The brand promise is inspired by the College’s mission and vision. It is an internal statement shared by our administration, faculty and staff that defines what Hope College promises to be and the experience an individual can expect to have when engaging with the institution. It is against this standard we will measure our work.

As a community and an institution, Hope College has many stories to tell. This brand promise guides and inspires us as we tell Hope’s story, now and in the future. It serves as a touchstone for planning, communications, marketing and evaluation. But it is strictly an internal guiding statement never to be published in marketing materials.
Brand Attributes

Brand attributes are key words and phrases that describe Hope College as it is and aspires to be. This language is used to be clear and relevant to the College’s key audiences.

Rare Combination
Rigorous academics and vibrant, inviting Christian faith combined to prepare students to live within a global society.

Picturesque and Welcoming Community
A historic campus, located just blocks from award-winning downtown Holland, and part of an engaging and increasingly diverse community that approaches relationships with respect, compassion and support.

Close Student-Faculty and Student-Staff Relationships
Masterful teachers and talented researchers in small classes and one-on-one collaboration, with a strong commitment to students’ personal, intellectual, social and career development.

Christian Character
Offers many voluntary opportunities to grow one’s faith in an inviting Christian community, while seeking to engage the whole person through academics and co-curricular programs.

Nationally Recognized Academics
Known for undergraduate research, scholarship, preparation, and life-shaping experiences.

These words and phrases originated from a March 2011 brand workshop, with input from the January 2011 surveys of staff, faculty, prospective and current students. These attributes were refined through consultation with administrators, alumni, trustees, faculty and staff.

Holistic Approach
Liberal arts and pre-professional programs with high academic standards and exceptional career opportunities. Holistic approach has been lauded for character, preparedness, service, and life-changing experiences for students.

Championship Athletics
Nationally competitive tradition with scholar-athletes, quality facilities, and a community that supports Hope teams.

Remarkable Facilities
World-class facilities that support the high caliber research, athletic, social and spiritual opportunities offered throughout the campus experience.

Vibrant Student Life
Commitment to the whole person, in mind, body and spirit, with an emphasis on cultivating relationships through award-winning social activities and unique traditions within a thriving and safe residential community.
Brand Concept – Fully Alive

By understanding the foundation for the creative concept, you will be better able to use it with confidence and create new materials that consistently embody the brand.

Deeply ecumenical, the “Fully Alive” concept can tap wisdom and spiritual values from diverse religious perspectives that teach mindfulness, inquiry, and living fully in the present. If we can reflect upon what connects us to life, love, faith, hope, peace, we perceive where it is God is most available to us, or more truly, where we are most available to God.

Hope graduates are educated to think about life’s most important issues with clarity, wisdom and a deep understanding of essential values of the Christian faith. They are prepared to communicate effectively, bridge boundaries that divide human communities, and to be “World Christians.” They are agents of hope who live faithfully into their vocation. Hope graduates make a difference in the world.

The “Fully Alive” concept expresses the mission of Hope College, the experience of Hope students, and the aspirations for its alumni. The College’s national reputation for academic excellence and its vibrant Christian atmosphere attract students who want an education that is life-changing and empowering.

Hope’s “fully alive” theme permeates all areas of life for Hope students and alumni and reflects the openness, grounding, and depth that characterize a Hope education. Students and graduates:

› explore who they are as people as well as future professionals
› forge relationships on a deeper level that take life seriously
› integrate spirituality into creativity and find a common ground
› understand how their beliefs can be lived out within a complex global society
Key messages, which are based on the brand attributes, are the most important talking points or copy points when communicating with Hope’s constituents. They differ according to the audience, and the nature of their relationship with Hope and what they may value as a result.

People’s engagement with Hope, and therefore their perspective and needs, change over time. They will want more or different things from the College as their relationship evolves. Those of us responsible for communications must understand the dynamic nature of our audiences—prospective students, current students, parents, alumni, donors, faculty, staff, community members—and how to best connect with them.

Choosing messages
Key messages, which are based on our brand attributes, are the most important talking points in communicating with Hope’s constituents. In choosing messages, we must keep in mind the audience and what they value. Think about Hope from their perspective. To be most effective, consider what messages will resonate as important and relevant.

We want our Hope community to understand “Hope lives in me”. Our culture and offering is inspired by an education that propels everyone forward towards a future with purpose. It will also be important to express the brand and messages in ways that resonate with a more broadly holistic and spiritual expression of the benefits of Hope.

Key messages that support our brand attributes
> Hope is a rare combination of nationally recognized academic excellence and its vibrant Christian atmosphere. At Hope, one’s personal faith is a choice, and voluntary chapel is full to capacity.

> Hope is a friendly and welcoming community where faculty, staff and students come to know and care about one another.

> Our 13:1 student-to-faculty ratio offers close collaboration and mentoring by faculty. Masterful teachers and talented researchers are committed to enabling students to achieve their best.

> With more than 80 majors in liberal arts and pre-professional programs, the college has high academic standards and exceptional placement opportunities. Our holistic approach has been lauded for character, preparedness, service and life-changing experiences for students.

> A research powerhouse, Hope’s faculty-student collaboration is funded by more than $5 million in active grants. The college holds more grants for faculty-student research from the National Science Foundation than any other undergraduate college in the country. Research Corporation ranks Hope at the top of their list for institutions receiving funding for undergraduate research.

> Hope is the only private, liberal arts college to have national accreditation in art, dance, music and theatre. The arts community is active and diverse, including 20-plus performing ensembles.

> Our 3,200 students come from more than 40 states and territories and 30 different countries. We are a leading college for Fulbright Scholars, and our students can look forward to attending their first choice of graduate and professional schools.

> We have a time-honored championship athletic tradition with scholar-athletes and a community that supports college teams. Hope has received the Commissioner’s Cup of the Michigan Intercollegiate Athletic Association for an unprecedented 12 consecutive years through the 2011-12 school year. Hope also sponsors several club sport opportunities and has an active intramural program.

> Hope has a beautiful, safe and historic campus, just blocks from the charming town of Holland, Michigan. The college has invested significantly in having the best facilities, and it is an increasingly culturally diverse community.
Brand Architecture

The brand architecture provides the structure for strategically managing how Hope College and its various units represent themselves to their audiences. It will promote consistency in application and define an understandable relationship and hierarchy.

Core Brand
The core brand is the consistent expression of the College’s brand promise, brand attributes and institutional personality based on the use of the logo, logotype, and brand identity.

Unit Identifier
Encompassed fully by the core brand, unit identifiers are used for those academic, administrative, and operational areas organized by department, office or work group.

Examples:
- Division of Arts and Humanities
- Department of Chemistry
- International and Multicultural Education
- Institutional Research
- Office of the Registrar
- Office of Student Life

Brand Extensions
These are defined as integral components of the core Hope brand with a distinct focus or initiative that directly supports the College’s mission.

Examples:
- Academic Support Center
- Center for Faithful Leadership
- Mellon Scholars Program
- Van Raalte Institute

Sub-Brands
Sub-brands are directly linked to the core brand but require some differentiation of expression or application because they serve a distinct service or need.

Examples:
- Athletics (Download the Athletics Sub-Brand Guidelines at hope.edu/brand)

Independent Brands
These brands represent a complete departure from the core brand identity, establishing independent identities that clearly articulate their distinct relationship to Hope College.

Example:
- Haworth Inn and Conference Center
The Integrated Marketing Planning Team (IMPT) has been working to advance the college’s strategic
marketing efforts on several fronts. These efforts have included the following:

- Defining a resource team (Integrated Marketing) to lead our efforts in implementing the redefined Hope
  brand throughout the campus.
- Define goals for the future.
- Providing some tactical help on specific college marketing initiatives.
- Considering the makeup of the IMPT and looking toward expansion.

With a presidential transition, we believe an interim approach makes more sense than committing to a
structure that will undoubtedly change. We’ve asked four persons who have been involved in this process to
dedicate up to fifty percent of their time to the marketing effort while also maintaining their current roles and
responsibilities. We have also hired two part-time communication specialists to join this team.

To sustain our current program, we will be providing resources to backfill for close to fifty percent of the team
members’ current job responsibilities.

Bill Vanderbilt, Admissions
Dave Vanderwel, Advancement
Co-Chairs of the Integrated Marketing Planning Team

CONTACT
Carol Fritz, Admissions
Messaging
fritzc@hope.edu
616.395.7045

Samantha Bruin, Communication Specialist
Design
bruin@hope.edu
616.395.7052

Scott Travis, Alumni & Parent Relations
Production
travis@hope.edu
616.395.7046

Jason Cash, College Advancement
Web
cash@hope.edu
616.395.7047

Rebecca Robrah, CIT
Design
robrahn@hope.edu
616.395.7044

Craig Tommola, Communication Specialist
Web
tommola@hope.edu
616.395.7048
LOGO STANDARDS

Logo 2.1
Configuration 2.3
Spacing and Dimensions 2.5
Color Specifications 2.7
Presidential Seal 2.12
The anchor has become synonymous with Hope and has roots in the College’s legacy. The metaphor originated from an observation the Rev. Van Raalte made regarding the Pioneer School: “This is my anchor of hope for this people in the future.”

This anchor was adopted as a symbolic icon and appears in the center of the rose window, and other stained glass in Dimnent Chapel. It is also the center of the college seal, the name of the college newspaper, and adorns the lawn in front of Graves Hall.

The logo’s anchor is drawn from the one in front of Graves Hall. The triangular border suggests the principles of mind, body, spirit associated with the College’s Christian heritage. The lines of the rounded triangle and anchor co-mingle.

Please note that this version of the anchor icon has been revised from the previous version. The difference is that the previous icon is a reversed version of the anchor that has a thin outline. This icon may no longer be used in any application.

Use of the icon by itself has restrictions. Please refer to Appendix A.4 for further guidelines on this type of usage.
This is the primary logo for Hope College. It consists of two parts: the name of the college, or logotype, and the anchor icon. This is an update of the previous logo.

The logotype uses two different typefaces. ‘Hope’ is set in Clarendon Bold, using both upper and lowercase letters. ‘College’ is set in all uppercase letters and uses Verlag Book.

Through consistent use of the Hope College logotype and editorial standards, Hope’s overall brand will be strengthened.

For further logo color specifications see Section 2.7.
The configuration of the horizontal logotype and icon appears below.

The spacing for the logo is based on $x$, which is equal to the width of the ‘O’ in ‘College’. The distance between the icon and the logotype and the two words of the logotype is $\frac{1}{2}x$. The baseline of the logotype aligns with the bottom of the anchor icon. The top of the ‘H’ in ‘Hope’ is exactly $\frac{1}{4}x$ from the top of the icon. The top of the ‘C’ in ‘College’ lines up with the top of the lowercase letters in ‘Hope’. These exact dimensions of spacing must be consistent in all applications of this logo version.

Download horizontal logo at:

[link to hope.edu/brand]
You may find that the horizontal logo version is not the best choice for some applications because it renders too small or fits awkwardly in the space. Below is the vertical version, designed to accommodate other space or size requirements.

This version may be used only if the layout does not permit use of the horizontal logo version.

Notice that in this version, the ‘H’ in Hope is aligned with the top of the anchor icon. The word ‘College’ also has more tracking between the letters to span the width of the icon and the word ‘Hope’ at the top. The spacing between the icon and ‘Hope’ is consistent with the horizontal version of the logo. The spacing between the icon and ‘Hope’ and the word ‘College’ is $x$.

Download vertical logo at: hope.edu/brand
The Hope logo must always have a clear space around it, where no other elements appear (no typography, other logos, graphics or photos may intrude upon the logo.)

Also, be careful not to place the logo too close to the edge of the paper, a folded edge or a cut.

The clear area for both horizontal and vertical is the height of the “O” in ‘College’.
The minimum sizes for the following logos are based on legibility of the icon or the text.

The smallest the icon size should be is .3” high. When using a logo variation without the icon (see A.2), the type in ‘College’ should be no smaller than 7 pt.
The two colors of the logo are the primary Hope College colors. These colors apply to both the horizontal and vertical versions of the logo.

Under no circumstances may any other colors or tints of a color be used. These colors apply to all versions of the logo including special use.

Two Color
The two color method should be used whenever possible on a white, cream, or other light-colored background (20% or less tint). The colors used are specific and restricted: the icon in Hope Orange (PMS 166), and the logotype in Hope Blue (PMS 289). This is done for brand recognition and consistency.

One Color and Black
When the entire project is one color, a one color logo may be used. The acceptable colors are either Hope Orange (PMS 166) or Hope Blue (PMS 289). An all black version may be used for black and white projects. Always choose the color version that provides the greatest contrast and readability.
When reversing the logo out of a color background, be sure the logo is large enough for the wordmark and symbol to be read clearly, with sufficient contrast.

**Reversed logo colors**
The one color (white) logo may be reversed out of any primary or secondary color with the exception of PMS 106 (Cottage Yellow) and PMS 317 (Macatawa Mist). See Sections 3.1–2 for more information about primary and secondary colors. The two color (PMS 166 and white) logo may be reversed out of a PMS 289 (Hope Blue) background. This is the only background color permitted for use with this type of reversal.

**Reversing out of a shape of color**
When reversing out of a square or rectangular shape of color, the area of color for the logo reversal must be at least twice the clearspace for the logo (please see Section 2.5 for clearspace specifications). The logo may not be reversed out of any shape other than a square or rectangle.

**Reversing out of a band of color**
When using a band of color for logo reversal, it must span the entire width of the page layout. The clearspace for the logo when placed within a band of color must be at least twice the size of the letter “O” in the logo on top, bottom, and on each side.
The logo may appear in one or two colors when using a background of screened color.

Only recommended tints of a color may be used as a background color. See Section 3.3 for further details.

If the logo is placed on top of a background color screened at 20% or less, the logo must print in its solid color form.

If the logo appears on a dark background color screen of 50% or more, the logo must be reversed.

Logo usage against screens between 20% and 50% is not recommended.

This applies for all logos within the system.
When placed on top of a photo contrast and color should be carefully considered.

If the logo is placed on top of or reversed out of a photograph, the area surrounding the logo must have very little pattern or texture and the background should provide distinct contrast so the logo appears legible and stands out noticeably. The logo should be of substantial size to identify the item clearly. The logo can print in one or two colors or be reversed in white.
Whether the logo prints in one or two colors or is reversed, it must appear against a background of sufficient contrast to provide clarity. Be sure to follow the color guidelines for logo specification and application.

Do not use unacceptable colors for the entire logo or for parts of the logo. This includes unacceptable use of brand colors. Do not add any effects such as bevels or drop shadows to logo. See Section 2.7 for logo color specification.

Do not reverse the logo out of unacceptable colors. Do not reverse only part of the logo out of a color. See Section 2.8 for logo reversal specification.

Do not reverse the logo out of a tint or screen lighter than 50 percent. Do not use a color or black logo on a tint or screen 50 percent or greater. See Section 2.9 for logo color specification with screens.

Do not place the logo on busy backgrounds of either photography or vector art. Do not reverse the logo out of a light-colored background. Do not put a color or black logo on a dark background, unless there is sufficient contrast. See Section 2.10 for logo specification on photography or vector art.
Hope’s name and seal both originate from an observation the Rev. Van Raalte made regarding the Pioneer School: “This is my anchor of hope for this people in the future.” The symbolism follows the Epistle to the Hebrews 6:19, “We have this hope, a sure and steadfast anchor of the soul... “

The Presidential Seal contains the anchor icon, which has become synonymous with Hope (see section 2.1). The Seal should be considered only for official documents of the College. Examples might include diplomas, certificates, legal documents, and special communications from the Office of the President. Permission from The Office of the Registrar must be sought for other uses.

Color Guidelines
Overall, always choose the color version that provides the greatest contrast and readability.

One color and reversals are the only color options, since the seal can not be reproduced using two colors. Only Hope Blue (PMS 289) or black are the preferred one-color applications. Black may be used if necessary but is not the preferred color choice. The seal may be reversed out of a color in using white. No tints or transparencies of the seal are permitted in any application.
BRAND IDENTITY

Color Palette  3.1  
Typography  3.5  
Photography  3.8
Orange and Blue are Hope’s primary brand colors.

Orange or Blue must be present in every layout with the exception of black and white media. These colors can be used in a variety of elements, including but not limited to type, photography, texture, graphics and the logo.

**Hope Orange**
- PMS 166 C
- 0/74/100/0 CP
- PMS 166 U
- 0/57/84/2 UP
- HEX # F46A1F
- R: 244, G: 106, B: 31

**Hope Blue**
- PMS 289 C
- 100/76/10/65 CP
- PMS 289 U
- 97/63/13/41 UP
- HEX # 002244
- R: 0, G: 34, B: 68

C/M/Y/K
- C: Coated Spot Color
- CP: Coated Process Color
- U: Uncoated Spot Color
- UP: Uncoated Process Color

Download color palette swatches at:

[hope.edu/brand](http://hope.edu/brand)
The secondary color palette is based on colors in the rose window of Dimnent Chapel and also reference elements unique to the Hope experience.

Eight colors were chosen as complements for each of the main school colors. Neutrals round out the set.

### BRIGHTS

- **Veneklasen Brick**
  - PMS 1535 C
  - 8/75/100/40 CP
  - PMS 1535 U
  - 10/52/92/24 UP
  - HEX # 91420E
  - R: 145, G: 66, B: 14

- **Tulip Orange**
  - PMS 130 C
  - 0/30/100/0 CP
  - PMS 129 U
  - 0/27/86/0 UP
  - HEX # F0AB00
  - R: 240, G: 171, B: 0

- **Cottage Yellow**
  - PMS 106 C
  - 0/1/70/0 CP
  - PMS 106 U
  - 0/1/74/0 UP
  - HEX # F7E654
  - R: 247, G: 230, B: 84

- **Spring Fling Green**
  - PMS 382 C
  - 28/0/92/0 CP
  - PMS 380 U
  - 15/0/65/0 UP
  - HEX # BED600
  - R: 190, G: 214, B: 0

### NEUTRALS

- **Black River Black**
  - PMS Process Black C
  - 0/0/0/100 CP
  - PMS Process Black U
  - 0/0/0/100 UP
  - HEX # 000000
  - R: 0, G: 0, B: 0

- **Pine Grove Green**
  - PMS 568 C
  - 89/11/48/47 CP
  - PMS 568 U
  - 91/13/62/23 UP
  - HEX # 00685B
  - R: 0, G: 104, B: 91

- **Lake Michigan Blue**
  - PMS 646 C
  - 73/30/3/10 CP
  - PMS 646 U
  - 62/29/10/4 UP
  - HEX # 5482AB
  - R: 84, G: 130, B: 171

- **Stained Glass Blue**
  - PMS 3125 C
  - 89/0/20/0 CP
  - PMS 3125 U
  - 62/0/18/0 UP
  - HEX # 00B0CA
  - R: 0, G: 176, B: 202

- **Macatawa Mist**
  - PMS 317 C
  - 24/0/7/0 CP
  - PMS 317 U
  - 32/0/14/0 UP
  - HEX # BBE7E6
  - R: 187, G: 231, B: 230

- **Graves Hall Gray**
  - PMS Cool Gray 11 C
  - 48/36/24/66 CP
  - PMS Cool Gray 11 U
  - 30/17/8/53 UP
  - HEX # 4D4F53
  - R: 77, G: 79, B: 83

---

Download color palette swatches at: hope.edu/brand

---

C/M/Y/K
- C: Coated Spot Color
- CP: Coated Process Color
- U: Uncoated Spot Color
- UP: Uncoated Process Color
Tints of the primary and secondary colors may be used to extend the color palette and for layering purposes.

Each color has a range of tints that may be used. The range was chosen based on several criteria: whether the tints hold true to the original color, whether the color is too light for use in print, and its overall aesthetic. Hope Orange (PMS 166) is the only color that may not be used as a tint.
The primary colors and secondary complements are intended to be used either together (analogous color for a more harmonious look and feel) or in contrast to each other. These are suggestions for usage and do not represent the only combinations.

The examples below show different proportions of these colors that may be used. Note that one of the primary school colors must be present in every layout but does not always have to be used dominantly. A layout is defined as either the entire piece (if it is single page such as an ad) or each cover, spread or web page within a multipage document or website.
The typefaces for Hope College are Verlag, Baskerville and Clarendon. Verlag is a sans serif, Baskerville is a serif and Clarendon is a slab serif.

**Headlines, Display and Callout**
The primary typeface for headline, subheads and callouts is Verlag. It can also be used as a display typeface. Verlag is a typeface based on Futura and other geometric type styles.

**Verlag**

**Body Copy and Callout**
The primary typeface for body copy and text on letterhead is Baskerville. It can also be used as a callout. Baskerville is a serif typeface and provides balance to the more rigid geometric typeface.

**Baskerville**

**Display Only**
The primary display typeface is Clarendon BT. Clarendon is a slab serif typeface. Its curvy lines are a nice contrast to sans serif typefaces and are a powerful choice for graphic typography. Display type refers to the use of type at large sizes. See further examples on sections 4.8 and A.8.

**Clarendon BT**

Request typefaces from:

[hope.edu/brand](http://hope.edu/brand)
If a project calls for a script font, Zapfino is recommended. Use of the script font should be carefully considered and used sparingly.

Special initiatives requiring a specific elegance such as a campaign or a formal gala event invitation would be good examples of appropriate typeface use.
As the number of standard web fonts is limited and not all computers have the brand fonts installed, two substitute typefaces have been chosen for Hope College: Arial and Georgia. Arial is a sans serif substitute for Verlag and Georgia is a serif substitute for Clarendon and Baskerville. These versions are to be used for digital applications such as website, email, and E-news content and only when absolutely necessary in print when primary brand fonts are not available.

For areas of a digital communication where typography might be used as a graphic element (such as a headline, call-out quote, drop capital), the official institutional typefaces are recommended for consistency. It is important to remember that when used this way, the type must be converted into a flat image such as a .jpg, .png, or .gif. This treatment is not recommended for body copy or other use where the information is critical.

Arial Regular
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Arial Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Arial Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Arial Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Regular
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Georgia Bold Italic
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
Photography is the primary means of visual storytelling within the portfolio of brand assets. Images can express the emotions, aspirations, inspiration, and transformations of Hope students, faculty, and staff. Images also visually reinforce the core brand attributes of the College.

Today’s digital media require powerful images to engage and hold a reader’s attention. In many cases, a carefully-selected photo can often say more than a paragraph of words but serve as a bridge for a reader’s interest to look deeper.

The goal is to capture the energy and emotion of a moment. People engaged in intense activities, genuine interactions, or spontaneous reactions can communicate a story. **Tip:** Instead of subjects looking directly into the camera, have them look at a point in a different direction and images will look more natural.

Composition is everything. As a general rule when selecting photography, choose images that are tightly cropped around the subject. Asymmetry, dramatic perspective and uncommon angles all make for a more powerful photo. Even a mediocre image can be improved with an interesting crop. Avoid the centered subject surrounded by lots of empty or dead space.

The best photos have contrast and saturated colors. Avoid flat, under or over-exposed images.

**Hope Photography Archive**
Hope College has an extensive photography archive that includes both topic specific and general brand imagery. For topic/event specific photos contact Public and Community Relations at 616-395-7860 or relations@hope.edu. For general brand imagery contact Integrated Marketing at 616-395-7150 or marketing@hope.edu.

**Custom Photography**
The advantage of custom images is the total control of the subject matter and composition available. But a custom photo shoot also requires careful, advanced planning and a coordination of numerous elements to ensure a quality result. Custom photography also requires release forms to be signed by all subjects for legal purposes. Please contact marketing@hope.edu to learn more.

**Stock Photography**
While the advantage is immediate availability at a reasonable price, the downside is the subject matter is generic and not campus- or person-specific. Because of this, purchased stock photography should not include people. Use of stock photography should be carefully considered and used sparingly.
The following photos show how the brand attributes can be expressed through photography. These examples demonstrate image style and composition. They are included to provide guidelines for choosing and crafting imagery.

**STUDENT-FACULTY/STAFF**

![Student-Faculty/Staff Images]

**CHRISTIAN CHARACTER**

![Christian Character Images]

**PICTURESQUE AND WELCOMING**

![Picturesque and Welcoming Images]

**NATIONALLY RECOGNIZED ACADEMICS**

![Nationally Recognized Academics Images]
The following photos show how the brand attributes can be expressed through photography. These examples demonstrate image style and composition. They are included to provide guidelines for choosing and crafting imagery.

REMARKABLE FACILITIES

CHAMPIONSHIP ATHLETICS

HOLISTIC APPROACH

VIBRANT STUDENT LIFE
BRAND APPLICATION

Print Examples  4.1–4.16
Digital Examples  4.17
This application shows how the brand elements are used for the approved business card layout.
This application shows how the brand elements are used for the approved letterhead layout.

Features of the layout to note:
1. Horizontal, 2-color college logo
2. Hope Orange (PMS 166) used for emphasis
3. Baskerville used for body of text (suggested text size is 10 pt / 15 pt)

See Page 3.7 for information on substitute fonts.

7.1.3 Add a bit to the left of the header. The college's “name” should be placed before the horizontal logo. This will help identify the college and the department.

We appreciate all you do for the college. Thank you for your support in keeping the Hope College story true to its brand. Please contact me with any questions or concerns.

Sincerely,
Carol Fritz

Order letterhead at:
hope.edu/brand
This application shows how the brand elements are used for the approved envelope layout.

**Features of the layout to note:**
1. Horizontal, 2-color college logo

Order envelopes at:

hope.edu/brand
Section 4 presents many examples of how the elements covered in Sections 2 and 3 can be combined in a layout. These examples do not present the only available options for layout. However, there are several cover options that may be used when the subject matter is appropriate.

Section 4 includes examples of how the brand can be applied. For support in creating publications like these please contact Integrated Marketing (Section 1.9).

**Triptych Cover**

The triptych example is best used when communicating to an audience who is encountering Hope College for the first time. It represents an intentional spectrum of our vibrant campus experience—beautiful facilities, engaged students, dynamic movement.

**‘Your Moment’ Cover**

The Moment example is best utilized when communicating to a reader that has some knowledge or prior touchpoint with Hope. The set-up is more thought-provoking and directly engages the reader by pairing a situation and question together to demonstrate the “moments” that live at the heart of the Hope experience.

**‘Engaged Student’ Cover**

The Engaged Student option is also best utilized when communicating to a reader that has some knowledge or prior touchpoint with Hope. The difference in this example is the questions is paired with photo of a singular student intensely engaged in an activity showing some spontaneous emotion. This cover uses a graphic color treatment specific a style of concept photography within the guidelines.
This application shows a suggestion of how the brand elements can be used in combination to create a “triptych” cover layout. The triptych approach expresses three aspects of the “Fully Alive” concept – vibrant campus life, engaged students, and dynamic movement.

**Features of the layout to note:**
1. Use of vertical strips for photo layout
2. Asymmetrical composition with layering
3. Campus beauty attribute photo
4. Full emotion photography and close-cropped photo
5. Motion blur photography
6. Transparency with graphic type
7. ‘Live It’ header paired with ‘spirit’ logotype
8. Hope logo is used on the back

**Suggested applications:**
- Brochure cover
- Poster
- Direct Mail
This application shows a suggestion of how the brand elements can be used in combination to create a “your moment” cover layout. This approach asks a question to engage the reader in what it means to be “Fully Alive.” The “Your Moment” cover pairs the question header with a singular image that expresses dynamic movement.

Features of the layout to note:
1. Motion blur photography
2. Use of question messaging
3. Asymmetrical composition with layering
4. Transparency with graphic type
5. Hope ‘spirit’ logotype
6. Hope logo is used on the back

Suggested applications:
- Brochure cover
- Brochure inside
- Poster
- Direct Mail
This application shows a suggestion of how the brand elements can be used in combination to create a “engaged student” cover layout. This approach asks a question to engage the reader in what it means to be “Fully Alive.” The “engaged student” cover pairs the question header with a singular image that shows a student engaged in a moment of spontaneous emotion.

**Features of the layout to note:**
1. Full emotion photography
2. Use of question header messaging
3. Asymmetrical composition with layering
4. Hope ‘spirit’ logotype
5. Hope logo is used on the back

**Suggested applications:**
- Brochure cover
- Brochure inside
- Poster
- Direct Mail

**Layout tip:**
Where can you make an impact?
This application shows a suggestion of how the brand elements can be used in combination to create a brochure interior.

Features of the layout to note:
1. Motion blur photography
2. Verlag and Clarendon in combination as graphic type
3. Large action word as graphic type
4. Subhead and body copy
5. Attribute photo
6. Layered transparency with color block
7. Asymmetrical photo layout
8. Enclosed icon
Steve Bouma-Prediger: Helping students find their true north

"From Genesis to Revelation, the Bible is a book of ecological wisdom and a book that calls us as humans to care for the earth."

On Steven Bouma-Prediger’s bookshelf, copies of the books he’s written flank a hiking boot – one he wore out long ago as an avid backpacker. He shares his love of the land with Hope students on his May Term course, Ecological Theology and Ethics, which takes the class to the Adirondacks in upstate New York. Under his guidance, students camp, canoe, raft and develop their leadership abilities as they examine the duties and responsibilities of being earthkeepers.

Our commitment to educating world citizens is demonstrated through off-campus initiatives. Hope offers a wide variety of May Term courses, which expand the scope of student study, give students an opportunity to work with professors like Dr. Bouma-Prediger, and distinguish Hope from other independent colleges.

A prolific author, his publications include For the Beauty of the Earth. A Hope alum, Dr. Prediger earned degrees from Fuller Seminary and the University of Chicago. He teaches religion and directs Hope’s Environmental Studies Program.

MILES OF TRAIL
14 STUDENTS
1 PAIR OF HIKING BOOTS

Features of the layout to note:
1. Asymmetrical photo layout
2. Object used for storytelling
3. Verlag and Clarendon in combination as graphic type
4. Transparency with graphic type
5. Enclosed icon

This application shows a suggestion of how the brand elements can be used in combination to create a brochure interior.
Hope will offer you a financial aid package to supplement your family contribution. Hope College aims to supplement the amount a student’s family will be expected to pay by offering a variety of federal, state and institutional financial aid. We usually start sending financial aid award letters by mid-March to students accepted as freshmen. Your financial aid package may include any or all of these types of financial aid: Merit Scholarships, Fine Arts Awards, Grants, Loans and Student Employment.

### Income Profiles of 2010–2011 Freshmen

<table>
<thead>
<tr>
<th>Total Parental Income</th>
<th>Number of Applicants</th>
<th>Number Eligible for Financial Aid</th>
<th>Average Amount of Package</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0-$10,000</td>
<td>160</td>
<td>160</td>
<td>$25,262-$33,983</td>
</tr>
<tr>
<td>$10,001-$20,000</td>
<td>25</td>
<td>25</td>
<td>$24,385-$29,300</td>
</tr>
<tr>
<td>$20,001-$30,000</td>
<td>65</td>
<td>65</td>
<td>$24,712-$30,252</td>
</tr>
<tr>
<td>$30,001-$40,000</td>
<td>109</td>
<td>107</td>
<td>$23,862-$29,437</td>
</tr>
<tr>
<td>$40,001-$50,000</td>
<td>104</td>
<td>104</td>
<td>$21,800-$29,912</td>
</tr>
<tr>
<td>$50,001-$60,000</td>
<td>157</td>
<td>155</td>
<td>$20,942-$27,092</td>
</tr>
<tr>
<td>$60,001-$70,000</td>
<td>173</td>
<td>171</td>
<td>$18,500-$24,912</td>
</tr>
<tr>
<td>$70,001-$80,000</td>
<td>158</td>
<td>157</td>
<td>$16,032-$23,988</td>
</tr>
<tr>
<td>$80,001-$90,000</td>
<td>159</td>
<td>155</td>
<td>$13,522-$21,784</td>
</tr>
<tr>
<td>$90,001-$100,000</td>
<td>131</td>
<td>124</td>
<td>$12,000-$19,190</td>
</tr>
<tr>
<td>$100,001-$110,000</td>
<td>163</td>
<td>152</td>
<td>$9,874-$18,012</td>
</tr>
<tr>
<td>$110,001-$120,000</td>
<td>101</td>
<td>93</td>
<td>$9,512-$17,730</td>
</tr>
<tr>
<td>$120,000+</td>
<td>646</td>
<td>310</td>
<td>$7,472-$15,600</td>
</tr>
<tr>
<td>Total</td>
<td>2,151</td>
<td>1,778</td>
<td>$19,701*</td>
</tr>
</tbody>
</table>

### Total Cost of a Hope College Education (2011–2012)

- **Direct Costs**
  - Tuition: $23,580
  - Room: $6,680
  - Board: $4,480 (reduced-cost meal plans are available)

- **Indirect Costs**
  - Books, travel, personal: $3,780

**Total:** $36,160

*Estimated maximum "room and board" package is $10,200. This amount is for students who have no family contributions toward their education. If a family holds significant assets, the figures may not be applicable.

### Step 3

- **Usage of Brand Elements:**
  - Attribute photo
  - Analogous color scheme
  - Verlag and Clarendon in combination as graphic type
  - Illustrative icons
  - Asymmetrical composition with layering

This application shows a suggestion of how the brand elements can be used in combination to create a brochure interior.
This application shows a suggestion of how the brand elements can be used in combination to create a brochure interior.

**Features of the layout to note:**
1. Analogous color scheme
2. Asymmetrical layout
3. Information graphic
4. Illustrative icon
5. Enclosed icon

**Scholarships:** Hope College awards academic and artistic scholarships that are not based on family financial circumstances. Academic scholarships are based on your classroom performance in high school and SAT or ACT results. The Office of Admissions must receive your complete application by February 15 to assure consideration for scholarships, including Distinguished Arts Awards offered in Art, Creative Writing, Dance, Music and Theatre.

**Awards for Academic and Artistic Merit For Freshmen Enrolling in the Fall Semester of 2012:**

<table>
<thead>
<tr>
<th>Scholarship</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trustee Scholarship</td>
<td>$17,000 per year</td>
</tr>
<tr>
<td>National Merit Scholarship</td>
<td>$17,000 per year</td>
</tr>
<tr>
<td>Presidential Scholarship</td>
<td>$6,000–$15,000 per year</td>
</tr>
<tr>
<td>Distinguished Scholar Award</td>
<td>$3,000–$6,000 per year</td>
</tr>
<tr>
<td>Values Scholar Award</td>
<td>$5,000 per year</td>
</tr>
<tr>
<td>Alumni Honors Scholarship</td>
<td>$3,000–$4,500 per year</td>
</tr>
<tr>
<td>Distinguished Artist Award</td>
<td>$2,300 per year</td>
</tr>
</tbody>
</table>

**APPLYING TO HOPE**

Hope accepts the Common Application. It is recommended that you apply early in the fall of your senior year; November 1 is our Early Notification Deadline. Any complete application by this date will be in the first group of files reviewed. Decisions for the Early Notification group will be sent out by Thanksgiving. To be assured consideration for merit-based scholarships, the Admissions Office must receive a completed application by February 15.

For more information on applying to Hope College, visit hope.edu/apply

**FINANCIAL AID AND SCHOLARSHIPS**

Need-based financial aid. No student should rule out Hope College because of cost. Our financial aid program awards more than $30 million each year to help students afford Hope College. Your eligibility for financial aid is determined by analysis of the Free Application for Federal Student Aid (FAFSA) and the Supplemental Application for Financial Aid (SAF). The FAFSA and SAF should be submitted by March 1 for freshman and transfer students.

For more information on financial aid, visit hope.edu/aid

**VISIT DATES**

<table>
<thead>
<tr>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Friday, September 10</td>
</tr>
<tr>
<td>Friday, October 15</td>
</tr>
<tr>
<td>Friday, October 21</td>
</tr>
<tr>
<td>Friday, October 28</td>
</tr>
<tr>
<td>Friday, November 4</td>
</tr>
<tr>
<td>Friday, November 11</td>
</tr>
<tr>
<td>Friday, November 18</td>
</tr>
</tbody>
</table>

**CONNECT WITH US**

<table>
<thead>
<tr>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facebook</td>
</tr>
<tr>
<td>Twitter</td>
</tr>
<tr>
<td>YouTube</td>
</tr>
<tr>
<td>hope.edu/visit</td>
</tr>
</tbody>
</table>

**BROCHURE SPREAD**
Hope offers a wide variety of May and June Term courses, which allow its nearly 4,000 students to experience a high level of personal growth and professional development. These initiatives demonstrate our deep commitment to educating global citizens. They also give students significant time with professors like Dr. Anne Brandon and Dr. Joel Toppen. “It’s a way to do a May Term course in Ronald,” Dr. Toppen says, her voice echoing the essence of a Hope College education, “rigorous, intense, combining the spiritual and cultural, and all of it coming together into one experience.”

Study aboard brings students face to face with both outer and inner realities. In the London May Term, for example, “We’re trying to understand presuppositions you hold that are important in how you see the world,” says Dr. Tom Smith. “When students return from study abroad, he challenges them, ‘Don’t just tell me what you did. Tell me how this will impact your life.’”

EDUCATING WORLD CHRISTIANS.

This kind of challenge reflects the fact that Hope “refuses to treat people narrowly,” says Professor Jeff Tyler. We’ve also defined our mission as a Christian liberal arts college in global terms. “We want to grow students with a global consciousness and critical discernment,” writes Trygve D. Johnson, Dean of the Chapel, “able to think and respond to the big issues of the world from a Christian point of view – issues from poverty and structural racism to environmental disasters.”

As a Hope student, you develop this ability through hands-on learning – experiences which expand your view of the world and your beliefs in the fundamentals you hold. Jeffrey Vredenburg ’11, a textbook example. He has combined an interest in conservation and sustainability with volunteer teaching and internships, as well as study and travel in China and South America. “That [last] trip gave me a solid platform to apply for a Fulbright,” he says, “since I had experience in Ecuador teaching English and working in ecology/conservation.”

Of course it won’t be enough for Jeffrey to teach English in Ecuador – experiences which expand your view of the world and your beliefs in the fundamentals you hold. “Instead of writing a paper, we each made a 12-minute documentary,” says Cara Green ’13, who shot footage while staying at a 6,000-year old abbey/hostel. “I focused on the difference between pilgrimage and tourism. The people shared such stories about their own experiences.”

This course, one of Hope’s newest May Terms, takes students to the cities, islands and highlands of Scotland – but most memorably inside the minds and hearts of the Scottish people. “It’s a way to do a May Term course in Scotland,” says Cara Green ’13, “combining the spiritual and cultural, and all of it coming together into one experience.”

GLOBAL EDUCATION

Do you just want a variety of experiences, or to learn how to integrate them?

This application shows a suggestion of how the brand elements can be used in combination to create a brochure interior.

Features of the layout to note:
1. Use of question header messaging
2. Asymmetrical photo layout
3. Full emotion photography
4. Enclosed icon
This application shows a suggestion of how the brand elements can be used in combination to create a three-panel brochure.

Features of the layout to note:
1. Use of question header messaging
2. Full emotion photography
3. Word ‘Hope’ is large since logo is not present on front
4. Analogous color scheme
5. Clarendon used as graphic type
6. Asymmetrical photo layout
7. Asymmetrical composition with layering
8. Logo is used on back of brochure
This application shows a suggestion of how the brand elements can be used in combination to create an insert template.

Features of the layout to note:
1. Full emotion photography
2. Clarendon used as graphic type
3. Clarendon used as graphic type
4. Enclosed icon
5. Asymmetrical photo layout
This application shows a suggestion of how the brand elements can be used in combination to create direct mail.

**Features of the layout to note:**
1. Clarendon as graphic type with ‘Live It’ header
2. Full emotion photography and close-cropped photo
3. Analogous color scheme
4. Motion blur photography
5. Layered transparency with color block
6. Attribute photo
7. Icon used as an information graphic
8. Use of vertical strips for photo layout
9. Logo is used on back of postcard
This application shows a suggestion of how the brand elements can be used in combination to create a poster.

Features of the layout to note:
1. Use of question header messaging
2. Word ‘Hope’ is large
3. Full emotion photography and close-cropped photo
4. Transparency with graphic type
5. Asymmetrical photo layout
6. Attribute photos
This application shows how the brand elements are used for the suggested email signature.

**Features of the layout to note:**
1. Alternate HTML typefaces are used for text formatting
2. Body copy is Arial Regular 12 pt. in Gray (#4D4F53)
3. Sender’s name is Arial Bold 12 pt. in Hope Blue (#002244)
4. Sender’s title is Arial Italic 12 pt. in Gray (#4D4F53)
5. Hope College is Georgia Bold 12 pt. in Hope Orange (#F46A1F)
6. Address and phone number is Arial Regular 12 pt. in Gray (#4D4F53)
7. Sender’s email address and college url are Arial Regular 12 pt. in Hope Orange (#F46A1F)
There are special use versions of the logo that may be used under certain circumstances.

These alternate logos may be used for external marketing purposes only. The addition of either the web address or the location of the college serves to inform audiences who may be unfamiliar with Hope College, such as those who are outside the Michigan area.

The web address and location for the college is always positioned as specified, below the logo in a smaller type size. The type is Hope Orange (PMS 166) for two color versions of this logo.

One color, black, reversals and use with screens and photography should follow the same specifications outlined in Sections 2.7–2.11 for the primary logo.

The clear area for horizontal and vertical orientation of both versions is the height of the “O” in ‘College’.

The minimum size is based on legibility of the text. The smallest size for the horizontal and vertical orientations of the web address logo are .4” and .5”. The smallest size for the horizontal and vertical orientations of the location logo are .4” and .5”.

Download special use logos at:

hope.edu/brand
There are special use versions of the logo that may be used under certain circumstances.

These department logos are examples of the shortest and longest departments. This format may be used to create logos for all department on campus. This version is intended for use by the specific department only in print and environmental applications.

The department name may only be used with the horizontal version of the logo. The name is always positioned as specified, below the logo in a smaller type size. If the department name is long it may be broken into two lines. If possible, please refrain from breaking the type so there is a single word on the second line. The type is Hope Orange (PMS 166) for two color versions of this logo.

One color, black, reversals and use with screens and photography should follow the same specifications outlined in Sections 2.7–2.11 for the primary logo.

The clear area is the height of the “O” in ‘College’.

The minimum size is based on legibility of the text. The smallest size for one- and two-line version of the logo is .4” and .5” high.
VERTICAL DEPARTMENT LOGO, TWO COLOR VERSION

MINIMUM SIZE

Minimum size: .5” high

Minimum size: .6875” high

CLEARSPACE
There are special use versions of the logotype that may be used under certain circumstances.

**Marketing/Spirit Logotype**
The marketing/spirit logotype may be used when a larger, more powerful graphic version of the logotype is desired for a marketing communication. This logotype may not appear without either type of the ‘Live It’ messaging or an identifying subhead (such as ‘Academics’). Messaging or subheads may use Verlag Book or Bold, and can appear as one or multiple lines of text. See Appendix A.14 for further detail on this type of messaging. The logotype must also appear in combination with the entire Hope logo either on the top, bottom or back of the piece.

Color specifications for the marketing/spirit logotype must follow the horizontal and vertical versions of the logo (see Sections 2.7–2.11). The marketing/spirit logotype may also be screened to a percentage of no less than 80% white. Clearspace is based on the height of the ‘O’ in ‘Hope’. The ‘Live it.’ messaging and identifying subheads are excluded from this clearspace regulation. The minimum size is based on the legibility of the type. For the full logotype, the type should be no smaller than 7 pt. or .125” high.

**Full Logotype**
The full logotype without the icon may be used in exceptional circumstances when the icon is unable to render using the desired production methods. An example of this is when the size requirement for the logo is less than the minimum size (.3”), such as on a pen.

Color specifications for the full logotype must follow the horizontal and vertical versions of the logo (see Sections 2.7–2.11). For the Hope logotype only, the clear area is the height of the ‘O’ in ‘Hope’. The minimum size is based on the legibility of the type. The type should be no smaller than 7 pt. or .125” high.
The icon may be used by itself under certain circumstances. Permission must be obtained from Integrated Marketing for use of the anchor icon by itself.

The anchor icon may be used when the context clearly references Hope College.

The icon may only be used in Hope Orange (PMS 166) or Black River Black. No tints are permitted for use.

Reversals of the icon may be used as long as the background color continues at least one icon width past the edge of the icon.

The Hope logo must always have a clear space around it, where no other elements appear. Clearspace for both icons is half of the icon height for all sides.

The minimum size is based on legibility of the icon. The smallest size for the anchor icon is .25” high.

Download special use logos at:

hope.edu/brand
Three types of concept photography are used – Motion Blur, Close-Cropped Profiles, and Full Emotion.

**Motion Blur Photography**  
This photo style captures the dynamic energy that surrounds the Hope experience. This technique can also be used as a portrait style that captures the singular experience of a person within the context of their environment.

**Close-Cropped Photography**  
This photo style creates a tight graphic focus. The subject appears moving just out of the frame of a photo, as if caught mid-motion.
Three types of concept photography are used – Motion Blur, Close-Cropped Profiles, and Full Emotion.

**Full Emotion Photography**

This photo style highlights the unique emotional energy at Hope within a full array of experience. The emotional impact is heightened by intensifying it in a vibrant color with the photo overlaid in black and white.

Use of this photography style can be either bold or subtle depending on the need and context. For example, a bold use of this style is more appropriate for prospective students, while a subtle use is more appropriate for donors. The styles can be mixed and matched depending on the need of the layout.

The bold style should use the background color and the grayscale photo at 100% intensity. The subtle style can use between 40–80% tint of the background color and 40–80% transparency of the grayscale photo. Enough contrast must be left between the background photo and color to be able to see the subject of the photo.

**Tip:** See Appendix B.1 for how to create these photographic effects.
There are two ways to approach photography layout. One is to use asymmetrically composed photos that are tightly spaced. The other is to crop photos vertically in thin strips. Both types of photo layouts use spacing between the photos of exactly 1/16” (.0625 inches).

**Asymmetrical Composition**
This approach is best used with multiple images and offers the greatest flexibility in terms of size and orientation of imagery. It is important to have one larger image that is the focal point and at least two smaller supporting images. Photos may either be directly aligned with each other or overlap.

**Vertical Strips**
This approach is best used with vertically oriented photography. Either one strip or tightly spaced multiple strips may be used. When using multiple strips, it is important to have one larger image that is the focal point. These photos directly align with one another and typically bleed off of at least one edge of the page.

Both of these approaches may be combined to add more visual interest.

---

**ASYMMETRICAL COMPOSITION**

**VERTICAL STRIPS**

**COMBINATION OF BOTH**
The brand relies on text for graphic impact. Layouts should use multiple typefaces and weights to provide texture and interest on the page. Text should not be used decoratively; it is important that the graphic text relate important information and maintain clear hierarchy within the layout.

**Verlag as a Graphic**
Any weight of Verlag may be used as graphic text. The text may be title case, sentence case, upper case or lower case. Graphic numbers should not use Verlag if they are over 24 pt.

**Clarendon as a Graphic**
Only Clarendon Roman, Bold and Black may be used. The preference is to use lower case for all graphic text with the exception of proper names and sentences. Upper case is not permitted. Graphic numbers above 24 pt. should use Clarendon only.

**Clarendon and Verlag in Combination**
Clarendon and Verlag may be used in combination as graphics, however one typeface must be dominant over the other.
Icons may be used to call out or visually connect important information on the page.

Icons should always be simple and two-dimensional, containing no drop shadows, bevels or reflections. All icon sets exist for use with both print and/or web materials. This set may be expanded to include purchased or created icons as long as they maintain the same look and feel.

**Illustrative Icons**
Illustrative icons may be used as a stand-alone graphic or in conjunction with information graphics. They are helpful when used to direct attention to specific information on a page, such as tuition cost breakdowns or ways to travel to Hope College.

**Enclosed Icons Including Social Media**
Enclosed icons signify a web link that leads you to more information. Enclosed icons come in two types: one for print- and email-based applications and the other specific for web-based.

Print- and email-based enclosed icons are always a white icon in a Hope Orange (PMS 166) circle. Exceptions to this format occur when there is too little contrast between the circle and the background. In this case an appropriate color or white must be chosen for the circle (see Section 3.1–3) to ensure contrast with the background color. The icon must be changed to match the background color.

Web-based icons are used only on the website. This icon set is comprehensive and includes all social media outlets. Currently, Hope College’s only approved social media channels include Facebook, Twitter and YouTube.

Request icons at:

[hope.edu/brand](http://hope.edu/brand)
There are two more types of graphics that may be used in conjunction with the rest of the brand elements:

**Icons and Information Graphics**

Information graphics may be used to visually relate important information on the page. Examples of this are typical bar charts, maps and graphs.

Information graphics should always be simple and two-dimensional, containing no drop shadows, bevels or reflections. Spacing between parts of the graphics should be 1/16” (.0625 inches).

**Objects**

Photographs of objects may be used to add more visual variety on profile/storytelling layouts. These images provide an additional layer of information for the reader and highlights the complexity and dynamism of the subject matter.

The objects should have a clipping path and a drop shadow. Objects may rest on either a color or white. **Tip:** The drop shadow must be at no more than 20% opacity, no more than .05” distance from the object and between 120 and 160 degrees.
The underlying structure of the layout is just as important as the graphics, type and photography of the brand.

A twelve-column grid is used for maximum flexibility in layouts. This allows for either even or odd numbers of columns across a page.

The grid provides the structure for the organized placement of elements on a page and in relationship to each other. Use the grid as the guide for sizing of all text boxes, photos, captions and call-outs.

Grid sizes for standard formats are available for download. See Appendix B.2 for how to create a 12-column grid using any document format.

Academically excellent and vibrantly Christian, Hope College inspires students to live life to the fullest—and achieve remarkable results. Here undergraduates explore ideas and faith freely and fully, with each individual deciding how deeply to become involved in religious life at Hope. This kind of freedom pours forth in late-night conversations, pioneering research, exhilarating performances, and music that makes spirits soar in Dimnent Memorial Chapel.

“... The faculty know us so well. They have been able to challenge me to play off my strengths and strengthen my weaknesses.”

Christopher Jackson, Keego Harbor, Michigan

Hope.edu/about
Hope College is a dynamic, exciting place to learn. An asymmetrical composition creates more interest and tension between the graphic elements to translate the Hope experience.

An asymmetrical composition can still achieve a visual balance without the elements being equally spaced or weighted. **Tip:** Choose an element to serve as the focal point for the layout, make it the dominant size, and place it off-center in the composition. Use the underlying grid to align the remaining elements in relationship to each other. This will keep the layout balanced, organized, and provide an information hierarchy.
Layering graphic elements evokes the movement and vitality of the students, faculty, staff and overall environment at Hope College.

**Overlapping Elements**

Areas of color, photos, type and graphics can align and overlap in many ways. Make sure visual hierarchy is maintained and all photos and text are legible when layering elements.

**Transparency**

Adjusting the transparency of an element can also be used to increase the effect of layering. Transparency can occur either as a graphic type treatment or a block of color.

Transparent graphic type can be layered either over photography or other elements on the page. The type must always be legible when used with transparency. Refrain from using this technique on type that is below 30 pt. in size or is too thin to be legible.

Transparent blocks of color may be used to increase the amount of color on a page, provide emphasis for an area and/or provide a space for type to layer over a photo. Type must always be legible when using a transparent color block over photography.
Live It Headers are a messaging element within the brand palette designed to pair with the singular Hope “spirit” logotype. These short, definitive statements reference “Hope” as both a College and an ideal. The energy of the statement expresses the “Fully Alive” concept.

Statements should always be limited to two or three words and end specifically with the word “it.” The statements can be crafted in two ways:

> in the Verlag typeface as a subhead, smaller and subordinate to the Hope “spirit” logotype.

> in the Clarendon typeface in equal weight to the Hope “spirit” logotype.
Question Headers are a messaging element within the brand palette designed to engage the reader in their own assessment of what it means to be “Fully Alive.”

The question header as a messaging tool is best when some set-up and exposure to the College brand has previously taken place.

A question header could typically be used on a marketing piece within a communication sequence where an individual has already received some College communication that includes the “Fully Alive” expression of campus life, people and dynamic movement. A question header could also be used in combination with these other ideas on the same piece.

Questions should be crafted to be succinct, direct and thought-provoking. The best questions will be between five to seven words in length.
Action Words are a messaging element within the brand palette designed to communicate the “Fully Alive” spirit that brings the Hope campus to life.

An Action Word is a single word treated as graphic text. It serves as a point of communication emphasis within a layout. Multiple Action Words may be used in a layout, however they must be consistent in size and approximate length. There are two ways actions can be used:

> as a graphic word that is part of a crafted headline and is necessary to complete the message

> as a graphic word that screens back behind text and highlights the topic, but is not required to complete a headline or subtext. The action word only serves as a point of emphasis for the topic.

Action words should be applied within a layout using a tint of the primary or secondary color palette. See Section 3.1–2 for how to correctly choose tints to create action word graphics.
Profile treatments can vary depending on the length of text. These are three solutions for profiles of varying length.
Trajectory treatments may occur in either print or web applications.

Features of the layout to note:
1. Close-cropped profile photography
2. Clarendon used as graphic text
3. Object used for storytelling
A special initiative, such as a Capital Campaign, will sometimes require a custom approach because the marketing intent is more strategically targeted. Layout and composition should draw from elements of the primary College brand palette, and a modified ‘look and feel’ must be complementary and cohesive. Here are suggestions for applying brand elements to a Special Initiative campaign.

Photography
The audience of the initiative should be kept in mind when choosing both general and concept photography. For example, close-cropped, portrait-style photos combined with the script typeface might be more approachable for fundraising with a mature, professional audience. In contrast, the bold style of the full emotion concept imagery may be more effective with recruiting a high-school-age prospect.

Typography
If the initiative has its own primary typeface, the primary typeface for Hope (Clarendon) may become a secondary typeface. In this case Clarendon may be used for subhead or headlines only. The primary typeface should be used as the display typeface.

Color
If there are any colors in addition to the primary and secondary brand colors they should be incorporated with the palette as a secondary color only. This ensures consistency through the dominant use of orange and blue.
Co-operative marketing opportunities are where the Hope College brand exists in relationship to a separately-defined entity, program or event. Examples might include Nykerk or Dance Marathon. In these cases, the Hope brand must appear in the design and be clearly-identifiable, but may be secondary in the information hierarchy.

A dedicated space must be established to clearly identify the Hope brand and position the College’s relationship to the opportunity.

Basic templates are provided for these poster and flyer applications to insure the correct representation of the Hope brand while allowing activity creators the necessary freedom to effectively address their audiences.

The dedicated brand space for each audience type may be used in either Hope Orange (PMS 166), Hope Blue (PMS 289) or Graves Hall Gray. Please take the overall poster design into account when choosing a suitable color option.

Download dedicated brand space templates at:

hope.edu/brand
This application shows a header and footer that can be used to create basic HTML emails. Arrangement of the photos and copy in the middle will vary depending on subject matter and email management system. This header and footer may be used for all Hope College e-communication.

**Features of the layout to note:**
1. ‘Live It’ header paired with ‘spirit’ logotype
2. Motion blur photography
3. Use of vertical strips for photo layout
4. Attribute photo
5. HTML text used for headlines, links and body copy

---

**Us et versped ut re nam uciet lorem ipsum**

Ugiae verspiti dent iumenda dunt untiis abo. Ugiae verspiti dent iumenda dunt untiis abo. Atatqua turehendiore nim quae assinimpos non restionetum qui odi dolupta turepudic te odis as imus dunt et placcus in core sequam nonsecae escilbus nemodit doltillatur, sit omni officie ndigenim numquos que dolorup tisqio idli apero tenihiiq pedone mostlonest facia sitatpu aerupudis exero omniiiti que nim ea cusam, con nis eosapide illis solupta dolorest dic te odis as imus dic te odis as imus?

See more about study abroad »

**Equassitiis dolesse quiscid ma**

Ugiae verspiti dent iumenda dunt untiis abo verspiti dent iumenda idium unum. Ugiae verspiti dent iumenda dunt untiis abo. Atatqua turehendiore nim quae assinimpos non restionetum qui odi dolupta turepudic te odis as imus dunt et placcus in core sequam nonsecae escilbus nemodit doltillatur, sit omni officie ndigenim numquos que dolorup tivm ea cusam, con nis eosapide illis solupta dolorest, volupit commis ducid est fugitam none quataur? Quisquat.

See more about Majors and Minors »

---

Download header and footer templates at:

[hope.edu/brand](http://hope.edu/brand)
Co-operative marketing opportunities are where the Hope College brand exists in relationship to a separately-defined entity, program or event. Examples might include Nykerk or Dance Marathon. In these cases, the Hope brand must appear in the design and be clearly-identifiable, but may be secondary in the information hierarchy.

A dedicated space must be established to clearly identify the Hope brand and position the College’s relationship to the opportunity.

Basic templates are provided for poster, flyer and t-shirt applications to insure the correct representation of the Hope brand while allowing activity creators the necessary freedom to effectively address their audiences.

**T-shirts**
There are three identifier options for T-shirts. The first displays the Hope logo on the upper left chest area, with the branded event/program logo and graphics on the back. The second displays the branded event/program logo and graphics on the front and the Hope logo on the back. The third option keeps the Hope logo on the left sleeve and the event/program logo and graphics on the front and/or back.

The same specifications apply for the logo when it is used on a T-shirt. Please see Section 2 for all specifications regarding logo usage.

**Tip:** If budget restrictions don’t allow for a two imprint shirt, please contact Integrated Marketing for assistance on an alternative design.
DESIGNER’S APPENDIX

Creating ‘Full Emotion Photography’  B.1
Creating a Grid Using Any Format  B.2
Content Needs List for HTML Email  B.3
Creating ‘Full Emotion’ Photography

Use of this photography style can be either bold or subtle depending on the need and context. Please read Section 3.12, which covers full emotion photography usage before you begin.

IN PHOTOSHOP

1. Select the photo you wish to use
   Photo selection will vary depending on the topic. Please select imagery that shows an emotion appropriate to the subject and tone you wish to convey—joy, determination, concentration, peace, etc. The photo may or may not be a close-cropped profile of a person (see Appendix A.5). Generally, more simple images work best as a larger scale photo such as a cover or poster. Secondary images in a layout may be simple or slightly more complex. Keep in mind that the photo will be reduced to grayscale and therefore some detail may be lost with the color change.

2. Change the photo’s color to ‘Grayscale’
   In the top bar, select Image > Mode > Grayscale. The computer may ask if it is OK to discard color information. Click the ‘OK’ button.

3. Increase the contrast of the image
   In the top bar, select Image > Mode > Adjustments > Brightness/Contrast. Make sure the ‘Preview’ box is checked. Grab the arrow under the ‘Contrast’ bar and pull it to the right. This will increase the contrast of the photo. Find a good balance of high contrast without loss of detail in the photo. Click ‘OK’ once you are satisfied with the result.

4. Save your photo with a different name
   It is often helpful to keep the original file name and simply add an extra couple of characters to designate it as a grayscale file. An example is to add '_bw' at the end. This way you can reference the original file if necessary.

5. Switch over to your layout in InDesign

IN INDESIGN

1. Create a background color
   Use your rectangle tool to create a background color for the photo. The color may be used at either full strength or a permitted tint of a color may be used (see Section 3.3). This decision should be based on the other colors within your layout as well as the ‘style’ of full-emotion photography you wish to use (see Appendix A.6).

2. Place your photo
   Draw a photo box over your colored background. This box should be the same size as the background. Select File > Place and browse your computer to find the image you just created.

3. Size your photo
   Using the Direct Selection tool, enlarge or shrink your photo within the photo box to the desired crop.

4. Change Transparency to Multiply
   Select your photo using the Selection tool, then select Object > Effects > Transparency from the top bar. Under the ‘Transparency’ header in the dialog box, use the drop-down menu to select ‘Multiply’. Select OK. This effect application should remove white from the photo, leaving only black with the background color showing through.

5. Make adjustments
   You may wish to make some additional adjustments at this point based on the ‘style’ of full emotion photography you wish to use.

   For Bold Style: Leave the background color and the grayscale photo at 100% intensity.

   For Subtle Style: Either the intensity of the background color or the grayscale photo may be altered. You may use between 40–80% tint of the background color and 40–80% transparency of the grayscale photo. Enough contrast must be left between the background photo and color to be able to see the subject of the photo. The transparency can be adjusted by selecting the object and adjusting the sliding arrow back and forth under ‘Transparency’ in the top bar. Tints can be adjusted at the top of the swatch palette (turn on under Window > Swatches in top bar).
Although grids for standard document sizes are supplied, you may wish to create your own grid based on a non-standard document size.

**IN INDESIGN**

1. **Create your document to your preferred dimensions and margin sizes**

2. **Find your Master Page**
   If you set up a grid on your master page, the grid will appear throughout your document where you have used that page. If you follow these instructions on a single page of the document, the grid will only appear on that one page.

   Master pages are displayed at the top of your ‘Pages’ palette. Click on ‘A-Master’ to access this master page’s layout. Note: if you make another master page type, you will have to repeat steps 2–3 to make a grid for this type of page.

3. **Create your grid**
   In the top bar, select Layout > Create Guides. In the dialog box, choose ‘12’ as your number of columns and either use the default gutter width or select your own preference. Under ‘Options’, choose the ‘margins’ button instead of the ‘Page’ button. This should create 12 equally-sized columns for each page of your document.
Production specifications provide consistency between multiple printed pieces. Paper and color are the two important tactile and visual cues of a brand.

**Paper Specifications**

Printer’s house sheet or an equivalent is fine for standard printing. A higher grade sheet is recommended for stationery suites.

Postcards, covers, brochures and accordian-style folding pieces:
80# Cover White Matte or Silk Coated

Interior pages of saddle-stitched brochures and inserts:
80# Text White Matte or Silk Coated

Envelopes:
70# or 80# Text White Uncoated

Cards that contain forms:
80# Cover White Uncoated (for ease of filling out form with pen)

**Color Specifications**

Orange is the most distinguishing brand color of the two primary colors. One-color pieces should use either orange or black. Two-color pieces should use orange and blue. If any element of the layout is unable to render in blue, black may be used instead. Any pieces with full-color photography must use four color process. If any piece has heavy coverage or very fine detail (such as small type) in any color other than black a spot color is suggested for best printing quality. An aqueous coating is suggested with all pieces run on a coated sheet.
CONNECT WITH US

希望.edu/brand
facebook.com/hopecollege
twitter.com/hopecollege
youtube.com/hopecollege